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INTRODUCTION 

The installation and implementation of the CyberStore 2 for SYSPRO software application 

falls into two categories: a Client/Server installation, and a Stand-Alone installation. The 

focus of this workbook is the Client/Server installation. 

Prior to starting the installation of the CyberStore 2 for SYSPRO software, there are a 

number of pre-requisite check-points that must be performed to ensure that your 

installation of the CyberStore 2 for SYSPRO is successful. Once the pre-requisites have 

been performed, you can then install the software.  

After the successful installation of the software, a number of post-requisite check-points 

are required to ensure the successful implementation of the CyberStore 2 for SYSPRO 

software. 

The following is an outline of the steps required for a successful installation and 

implementation of the CyberStore 2 for SYSPRO application: 

 Installation Pre-Requisites – these steps and checks must be performed to ensure that

your system meets at least the minimum requirements for a successful installation.

These checks will include hardware settings, and security.

 Install the CyberStore 2 for SYSPRO software on the web server

 Post Installation Checks and Configuration

 Configure CyberStore 2 for SYSPRO

 Customize site pages to meet design specification

 Populate CyberStore 2 for SYSPRO data and images

 Perform tests on: The layout of the site, The data displayed in the CyberStore, Place

order via the CyberStore and test these orders

 Once the site has been thoroughly tested, you are ready to go live with CyberStore 2 for

SYSPRO

This installation package of the CyberStore 2 for SYSPRO software is compatible with 32-

bit Windows and 64-bit with 32-bit applications enabled architectures. 

This document is copyrighted by Dovetail Internet Technologies, LLC., the developers of CyberStore 2 for 

SYSPRO (www.CyberStoreForSYSPRO.com).  

The name SYSPRO and other information contained in this document and the application are used with the 

permission of SYSPRO Impact Software, Inc. (www.syspro.com)  

http://www.dovetailinternet.com/
http://www.syspro.com/
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CHECK-POINTS 

The pre-requisite check-points detailed in this chapter must be performed prior to 

attempting the installation of the CyberStore 2 for SYSPRO software. 

These pre-requisite check-points cover the following aspects of your installation: 

 Network, Web Server and Internet Connectivity 

 Windows Server Security 

 SYSPRO and SYSPRO e.Net 

 

1 WEB SERVER PRE-REQUISITES 

It is recommended that the CyberStore 2 for SYSPRO software is installed on a 

dedicated server separate from the SYSPRO ERP software server. This web-server 

will act as a stand-alone server. 

1.1 Hardware Requirements 

The minimum hardware requirements for the web server are: 

● Pentium 4 - 2.5 GHz (dual processor preferred) 

● 2 GB RAM 

● 100 MB of available hard drive space for the CyberStore 2 for SYSPRO software 

● 1 GB of available hard drive space for documents and other images which may 

be required to customize/personalize the installation of CyberStore 

1.2 Software Requirements 

CyberStore can be simply installed on most Windows systems. However, you must 

first make sure that you have the proper prerequisite software installed. 

Prior to installing, please make sure you have the following software installed or 

properly updated: 

Microsoft Windows Server 2008, Server 2008 R2 (64-bit) 

CyberStore runs in a 32-bit environment. If you are installing on a 64-bit operating 

system, you will need to enable 32 applications within Internet Information Server 

(IIS). Information on this procedure is available in a Microsoft TechNet Article 

(http://technet.microsoft.com/en-us/library/cc755457(WS.10).aspx) 

http://technet.microsoft.com/en-us/library/cc755457(WS.10).aspx)
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Any of the *Full* Windows Server Editions including Standard, Enterprise, or Data 

Center or the Special Purpose Edition Web is adequate. However, do NOT use 

“Server Core Installation” versions as these do not have a GUI interface. 

WARNING: Your installation of Windows must have a NTFS partition which 

CyberStore and associated content files will exist on. 

Microsoft Internet Information Services (IIS) 7.x 

On Windows Server 2008: This requirement can be installed through Start -> All 

Programs -> Administrative Tools -> Server Manager. You will then need to add the 

Web Server (IIS) Role. 

IMPORTANT: IIS 7.x will have separate Application Pools per virtual site by 

default. 

Additional Configuration of Internet Information Services 7 Role Services 

The Internet Information Services (IIS) 7 Pre-Requisites listed below are required 

for Windows 2008 and Windows 2008 R2 web servers. 

Install the Web Server (IIS) Role 

 Open the Server Manager in the Administrative Tools 

 Select Roles 

 Locate the Web Server (IIS) section and click “Add Role Services”. If the “Web 

Server (IIS)” role is not already present, click “Add Roles” and select the “Web 

Server (IIS)” role to be added. 

 Choose the appropriate IIS Modules to be installed. See Figure 1-1. IIS 7 

Installation Options and Figure 1-1. IIS 7 Installation Options 

  for details of which modules should be installed. 
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Figure 1-1. IIS 7 Installation Options 
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Set Role Service Options 

In the Confirm Installation Selections interface, review the selections and set the 

following Role Service Options: 

Common HTTP Features (Partial) 

 WebDAV Publishing – Uncheck 

 All other options – Check 

Application Development (All) 

 All options – Check 

Health and Diagnostics (Partial) 

 Custom Logging – Uncheck 

 ODBC Logging – Uncheck 

Security (Partial) 

 Digest Authentication – Uncheck 

 Client Certificate Mapping Authentication – Uncheck 

 IIS Client Certificate Mapping Authentication – Uncheck 

 All other options – Check 

Performance (All) 

 All options – Checked 

Management Tools (Partial) 

 Management Service – Unchecked 

 All other options – Checked 

IIS 6 Management Compatibility (Partial) 

 IIS 6 Metabase Compatibility – Checked (Optional) 

 
Then click Install. Allow the installation process to complete and then click Close. 
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Microsoft .NET Framework Version 4.0 

Ensure .NET Framework Version 4.0 is installed 

Depending on the version of Windows Server 2008 that was installed the .NET 

Framework version 4.0 may already be installed!  

For more information on installing .NET Framework 4.0, please read this Microsoft 

Article (http://www.microsoft.com/download/en/details.aspx?id=17851). 

Virtual Website in IIS 

The CyberStore will reside within a virtual website. You may either use the default, 

an existing site or create a new one. 

The “Ecommerce” and “Console” Virtual Directories will be created within this 

Virtual Website during the CyberStore application installation. 

Create a new web site on the webserver 

 Open IIS7 (Start > Run > inetmgr) 

 Expand the webserver 

 Right-click on Sites 

 Click “Add Web Site” 
 

 

Figure 1-2. Adding a new website 
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Complete the dialog box 

 Enter a name to reference your site. Note: Any name is fine-- 

Example A: “www.theoutdoorscompany.com” 

Example B: “CyberStore2” 

 Click the browse button (“…”) Select the physical path where you would like the 

website root to be placed.  

Example A: “C:\inetpub\CyberStore2root” 

Example B: “D:\www.theoutdoorscompany.com\wwwroot” 

Note: It is common to place non-system files on a separate partition such as D:\ 

from the system files which are usually on C:\ 

 Click “Make New Folder” button 

 Enter the physical directory name for your site. 

Note: Any name is fine. However, for simplicity you may want to use the typical 

website root folder name “CyberStore2root”. 

 Click “OK” 

 

Figure 1-3. Naming your new website 

http://www.theoutdoorscompany.com/
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Enter website addressing information 

 IP address – To start with use an Internal IP. 

IMPORTANT: The Internal IP will be updated with an External IP before you 

Go Live unless you are using Natural Address Translation (NAT). 

 Leave Host name blank. 

 Click “OK” 

 

Figure 1-4. Setting addressing for your new website 

IP Address 

 Setup the Network (firewall and router), Server (NIC) and Web Site (IIS) to 

respond to the assigned IP address. 

NOTE: If you are on the web server you may refer to the default website as 

(localhost) 
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IMPORTANT: If using a private IP while staging the site then a public IP must 

be configured at Go Live. 

Patch O/S and IIS 

 Install all Security Updates 

 Review and install any Important or Critical Windows updates that relate to 

required components being used. 

SSL Certificate 

An SSL Certificate for full “Common Name” of the website--subdomain and domain 

name of CyberStore site (e.g. ecommerce.yourdomain.com will be necessary for Go 

Live.  

Beginning the process to determine first the Common Name that will be used for 

the CyberStore site. 

 Review the types of SSL certificates and decide which you will want. 
 Generate the request and begin the process to obtain a certificate. 

Note: For more information or to order a certificate visit:  

http://www.CyberStoreForSYSPRO.com/SSL-COMPARISON-CHART 
Note: You may consider using a self-signed certificate for demo or test sites. 

 

2 WEB DATABASE SERVER PRE-REQUISITES 

The CyberStore SQL Databases will be on a separate server from the Web Server. 

2.1 Hardware Requirements 

The minimum hardware requirements for the web server are: 

● Pentium 4 - 2.5 GHz (dual processor preferred) 

● 2 GB RAM 

● 100 MB of available hard drive space for the CyberStore 2 for SYSPRO software 

● 1 GB of available hard drive space for documents and other images which may 

be required to customize/personalize the installation of CyberStore 

http://www.dovetailinternet.com/SSL-COMPARISON-CHART
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2.2 Software Requirements 

Microsoft SQL Server 2008, x64 SP1 or R2 

Any of the *Full* SQL Server Editions including Standard, Enterprise or Datacenter 

or the Special Purpose Express Edition is adequate. 

WARNING: Microsoft SQL Server 2008 may NOT be installed on the Microsoft 

Server 2008 Web Edition operating system. 

Check the Version of your SQL Server 

To determine the version of the client tools that are installed on your system, start 

Management Studio, and then click “About” on the Help menu. For other methods, 

please refer to the Microsoft Support article: 

(http://support.microsoft.com/kb/321185). 

 

 

Figure 2-1. SQL Server 2008 R2 Installation Information 

http://support.microsoft.com/kb/321185


CyberStore 2 for SYSPRO Installation and Upgrade Guide  

©2013 Dovetail Internet Technologies, LLC All rights reserved.  Page | 18 

Enable Named Pipes 

To enable named pipes do the following: 

 Logon 

 Run SQL Server Configuration Manager 

 Navigate to SQL Server Network Configuration -> Protocols for 

MSSQLSERVER 

 Confirm that Named Pipes is enabled 

 

Figure 2-2. SQL Server Configuration Manager - Enable Named Pipes 

 

3 NETWORK AND INTERNET CONNECTIVITY 

The Web Server that will be used for CyberStore 2 for SYSPRO must be setup and 

hosted within the same physical network as the server hosting the core SYSPRO 

ERP application. 

Prior to installation of the CyberStore 2 for SYSPRO software, the following must 

be in place. 

3.1 Network Configuration 

High speed internet 

Confirm that high speed internet service is available to host your CyberStore 2 for 

SYSPRO installation. Please note that some Internet Service Providers (ISPs) have 

terms of service which may limit or forbid the use of a web server on their network. 

Consult your ISP’s terms of service for more information. 



CyberStore 2 for SYSPRO Installation and Upgrade Guide  

©2013 Dovetail Internet Technologies, LLC All rights reserved.  Page | 19 

Domain Name and URL 

Select and register the domain name and URL that will be used for the website, for 

example cyberstore.yourdomain.com. Your ISP should be able to assist you with this. 

External Public IP Address 

Assign an external public IP address to the server that can be mapped from the 

World Wide Web to the virtual website. Your ISP should be able to assist you with 

this. 

3.2 Network Security 

Configure Network for HTTP and HTTPS access 

Your network must be configured to allow HTTP (TCP port 80) and HTTPS (TCP 

port 443) access to the web server for the external public IP address that will be 

used for the website. This configuration must include any Gateway Router; 

Perimeter Firewall, software firewall, etc. 

Acquire an SSL Certificate 

This is required to encrypt data transmissions based on the domain name. 

Customers who place sales orders via your website will want to know that their 

information is safe and an SSL certificate is one way to ensure that the information 

your customers entrust to you via your website is secure. 

Once the certificate has been installed, any pages using the SSL certificate, will 

display a small padlock on the browser status bar, indicating that the page is secure 

and a certain level of security is in force. Your internet service provider should be 

able to assist you with obtaining and installing this certificate on your web server. 

NOTE: While it is possible to use CyberStore 2 for SYSPRO without an SSL 

certificate, it is highly recommended that every live site uses the SSL certificate. We 

typically recommend that the SSL certificate is obtained from a reputable 

organization such as Network Solutions or VeriSign. 

3.3 Windows User Accounts 

CyberStore 2 for SYSPRO relies on specific Windows User Accounts in order to 

operate.  

Depending on the network architecture, either local user accounts on the servers 

or Active Directory (AD) user accounts may be used.  
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Web Server and Web Database Server 

CyberstoreBrowsers and CyberStoreManagers 

This user account may be created by the CyberStore Installation Wizard. If using 

LOCAL user accounts the Wizard must be run as the local system administrator. If 

using AD user accounts the Wizard must be run as a Domain Administrator.  

Otherwise, the user account needs to be created manually prior to the installation 

of the CyberStore 2 for SYSPRO software. This user account is utilized 

transparently by site visitors to access web resources. 

IMPORTANT: If you create users Manually they must be added to the local IIS 

Anonymous Group which is either called “IIS_USRS” or “IIS_WPG”. 

 

SYSPRO Server and SYSPRO Database Server 

CyberstoreRemoting 

This user account is created manually and used on the SYSPRO Application server if 

Microsoft .NET Remoting service is used for SYSPRO e.net communications between the 

Web server and the SYSPRO server. It is referred to as the “Service User” in section  

0Natively, communication between SYSRPO and other applications through e.net is 

configured through standard Windows COM/DCOM communication. Though CyberStore 

2 for SYSPRO can utilize that default setup, it is recommended that installation forgo the 

use of COM/DCOM and utilize one of the supported communication services instead.  

CyberStore 2 for SYSPRO can be configured for either of the following communication 

protocols: 

● CyberStore 2 for SYSPRO .NET Remoting Service 

● SYSPRO Web Services 

 

The following sections describe each option and how to go about installing and utilizing 

each.  

Please note that it is neither necessary nor desired to install both .NET 

Remoting and SYSPRO Web Services for communication with SYSPRO.  
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For guidance on determining which method is best suited for your 
implementation, please consult with your CyberStore 2 for SYSPRO 

implementation team. 

 

.NET Remoting Service . This is the user under which the .NET Remoting Windows 

Service runs. 

4 SYSPRO SETUP PRE-REQUISITES 

All interaction between CyberStore 2 for SYSPRO and the core SYSPRO ERP 

product is handled through SYSPRO e.net solutions.  

When the CyberStore requires data, it does not directly access the SYSPRO 

database. Instead, it uses e.net Business Objects which in turn will access the 

SYSPRO data. This same path is followed when the CyberStore needs to write a 

transaction into SYSPRO, for example a sales order captured via your website. 

4.1 Before CyberStore 2 for SYSPRO Installation 

Before the CyberStore 2 for SYSPRO software is installed, the following needs to 

be in place: 

SYSPRO ERP application is installed 

CyberStore is integrated with the SYSPRO ERP application and therefore it must 

be installed first. 

WARNING: Although multiple instances may be configured to exist on a single 

server the default SYSPRO e.net settings and installation wizard are designed 

to install one instance. If you have more than one instance on the same server 

SYSPRO technical support may be required to configure the e.net objects to 

interact with the instance that will be used by the CyberStore. 

Upgrade the SYSPRO ERP application 

To the current supported version and issue, including the current port level. The 

minimum requirement is SYSPRO 6.0 issue 10.  
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Install SYSPRO e.net solutions including the Diagnostics Tool 

On the SYSPRO Server. On SYSPRO 6.1, this feature may be installed 

automatically. This is available as an option on the SYSPRO version 6 Issue 10 

Installation CD for Networks and Servers.  

4.2 SYSPRO Licensing 

Configuring the SYSPRO e.net solutions licensing is accomplished in one of two 

ways: 

SYSPRO e.net Runtime Licensing (recommended) 

If e.net runtime licensing is being used, then you will see the CyberStore Product 

listed under the e.net Run Time Products button in the Company > Registration 

screen.  

If you do not see the CyberStore license, then you will need to import a new license 

file. Navigate to Setup > Companies > Change > Registration Tab then select to 

Import LICENSE.XML. Locate and import the XML file as provided to you by SYSPRO, 

which contains the required license information. 

SYSPRO e.net Business Object Licensing 

If e.net runtime licensing is NOT being used, then you will need to allocate e.net 

licenses to the WEB and operator 

To configure this, login to SYSPRO and then from the SYSPRO main window, select: 

Setup > System Setup > Configure e.net License Select Business Objects, then select 

each of the following functional areas, and mark the WEB operator as Licensed: 

▪ A/R Primary Query 

▪ Inventory Primary Query 

▪ Sales Order Primary Query 

▪ Sales Order Primary Posting 
 

When you have completed this for each Functional Area, you may then close the 

window and click the Finish button on the final screen to apply the changes. 
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4.3 SYSPRO e.net Configurations 

Verifying that e.net Browse have been setup 

Verify that the e.net Browses required by the CyberStore 2 for SYSPRO exist. 

These browses are normally included in the install of core SYSPRO. To check 

whether these Browses have been created, from the SYSPRO main menu select: 

SYSPRO main menu > e.net solutions > Browse Setup 

Check that the following Browses exist: 

● InvMaster 

● ArCustomer 

● TblSoShipInst 
 

If these browses do not exist, then reference your SYSPRO documentation on how 

to create each Browse, or contact your Technical Support Consultant. 

4.4 SYSPRO Operator and Group Setup 

One Operator Group and one Operator Account must be created in SYSPRO. In 

addition, a Network User Account must also be created for this operator. As 

CyberStore 2 for SYSPRO makes use of e.net to read and write from/to SYSPRO 

data, it is necessary that the correct security is configured in SYSPRO against for 

this operator and group. 

Creating Your Web Group 

To access the Group setup in SYSPRO, from the SYSPRO main window, select: 

Setup > Security > Groups 

Create an operator group called WEB, to be used by the CyberStore. 

e.net Security By Operator Group 

Assign e.net access permissions to the relevant e.net business components. 

To configure these permissions, from the SYSPRO main window, select: Setup > 

Groups > Highlight the WEB Operator Group created above > Modify (aka 

“Hammer & Sickle”) 

In the Operator Group Maintenance screen, the business components (Programs) 

to be checked are listed within their respective Module. Sort the displayed list to 

make this task easier. Click on the Module button to sort the Modules. Then click 
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the Program column header to sort the Programs. Using the following list, ensure 

the required business components are checked to indicate Access allowed. 

 

Module:  e.net Solutions - Query 

ARSQCR A/R Credit Management Query 

ARSQRY A/R Customer Query 

INVQRW Inventory Where-Referenced Query 

INVQRY Inventory Query 

SORQCP S/O Sales Order Contract Price Query 

SORQDL S/O List of Dispatch Notes 

SORQDN S/O Dispatch Note Query 

SORQOV S/O Sales Order Valuation Query 

SORQRY S/O Sales Order Query 

SORQSO S/O List of Sales Orders.ascx 

 

Module:  e.net Solutions - Transaction 

AUNTCT Credit Card Transaction Import 

SORRSH S/O Build Sales Order Header 

SORRSL S/O Build Sales Order Line 

SORTOI S/O Sales Order Import 

 

Module:  e.net Solutions - Utility 

COMBRW Generic Browse 

COMFCH Generic Fetch 

COMFND Generic Find 

COMKEY Get Previous/Next key 

COMPRF Profile Settings Query 

COMQFM Custom Form Query 
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Figure 4-1. SYSPRO – Group Security Setup 

 

Figure 4-2. SYSPRO – Operator Group Maintenance –  

Security Access for SYSPRO e.net Objects/Modules 
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Figure 4-3. SYSPRO e.net solutions Browse Setup 

 

Creating Your WEB Operator 

 To access the Operator setup in SYSPRO, from the SYSPRO main window, 

select: Setup > Security > Operators 

 Create one operator account, for example called WEB which will be used for 

reading and creating transactions through the CyberStore 2 for SYSPRO front-

end application. 

 This operator should be assigned to the Operator Group defined above. All 

Operator settings and security applied to this Operator will affect the website’s 

users. 

 Any Username and password changes that occur in SYSPRO will have to be 

applied to this operator via the CyberStore 2 for SYSPRO Management 

Console. 

 Once the operator account has been created, define a password: 

▪ Select the Security Tab and enter a Password for the operator. 

▪ Please note: This Web Operator’s password cannot be blank 
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4.5 SYSPRO Operator Default Settings 

Define a Default Company for the WEB operator 

 This operator must have a Default Company defined as this is the Company that 

the CyberStore 2 for SYSPRO will look to for Inventory and Customer 

information. 

 To set the default company for each operator, from the SYSPRO main window, 

select: Setup > Security > Operators 

 Select the operator account to maintain and then select Change. 

 Navigate to the Defaults tab and at the Company prompt enter the default 

Company ID that you will use for CyberStore, for example 0 (zero) 

Setting the Warehouses for the WEB Operator 

 Warehouse visibility must also be defined for the WEB operator. For an item to 

be orderable, it must be in one of the Warehouses specified against the WEB 

Operator’s Warehouse selection options. 

 If any item in a customer’s order is not in a specified warehouse, the order will 

not be submitted. An error message will be displayed informing the customer 

that there was an error processing the order and that the order has not been 

accepted. 

 To define the Warehouse selections for the Web Operator, from within 

SYSPRO, select: Setup > Security > Operators 

 Select the operator to maintain and then select Change. Navigate to the e.net 

tab, select the Customer Orders button, and then select Warehouses. 
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Figure 4-4. SYSPRO – Operator Maintenance –  Warehouse selection 

 

Setting up the Default Customer for CyberStore 

 Create a Customer account in Accounts Receivable which will be used as the 

Default Web Customer for all B2C (consumer) purchases placed online through 

the CyberStore 2 for SYSPRO. 

 These orders processed on the web are submitted through to the SYSPRO Sales 

Order program against a single customer, i.e. the web customer you created. 

 Shipping details for each order received will be associated with the individual 

sales order within SYSPRO. 

 To create a customer account, from the SYSPRO main menu, select: Accounts 

Receivable > Setup > Customers 

 Enter a code and a name for the new web customer, and select a valid: Branch, 

Salesperson, Invoice Terms, and a currency code. 
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Figure 4-5. SYSPRO – AR Customer Maintenance – setup default customer example 
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Defining the Default Order Type Required for CyberStore 

 Verify that a Default Order Type has been defined in SYSPRO. When Sales 

Orders are recorded in SYSPRO from CyberStore, a default Order Type is used. 

If a Default Order Type has not been defined, sales orders from CyberStore will 

fail to post to SYSPRO, if in SYSPRO the setup required that default order type 

must be validated. 

 To define this default, select: Setup > Distribution Setup > Sales Orders > 

General 2 tab. 

NOTE: The alternate key field will be set to “WEB” on all orders placed via the 

CyberStore 2 for SYSPRO. 



 

 

SYSPRO COMMUNICATION 

SERVICES 
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Natively, communication between SYSRPO and other applications through e.net is 

configured through standard Windows COM/DCOM communication. Though CyberStore 

2 for SYSPRO can utilize that default setup, it is recommended that installation forgo the 

use of COM/DCOM and utilize one of the supported communication services instead.  

CyberStore 2 for SYSPRO can be configured for either of the following communication 

protocols: 

● CyberStore 2 for SYSPRO .NET Remoting Service 

● SYSPRO Web Services 

 

The following sections describe each option and how to go about installing and utilizing 

each.  

Please note that it is neither necessary nor desired to install both .NET 
Remoting and SYSPRO Web Services for communication with SYSPRO.  

For guidance on determining which method is best suited for your 

implementation, please consult with your CyberStore 2 for SYSPRO 

implementation team. 

 

5 .NET REMOTING SERVICE  

5.1 Overview 

The .NET Remoting Service is a program that runs as an installed service on the 

SYSPRO Server and provides access to the e.net objects. This communication 

mechanism is intended for use with CyberStore 2 for SYSPRO only. 

For the .NET Remoting Service installation to be successful, there are certain 

system requirements that must be adhered to. This section details those 

requirements and then takes you through the installation process. 

5.2 Installation Requirements 

● .NET framework. Version 4.0.30319 installed on the SYSPRO ERP Server 

● The IP address of the SYSPRO ERP Server 

● Port Number through which the servers can communicate and network 

connectivity between SYSPRO ERP Server and the Web Server on that port 

● Service User credentials including a username and password of the User the 

service will logon as. This is usually CyberStoreRemoting. 
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5.3 Installation Process 

Copy installation files to SYSPRO ERP Application Server 

The installation files required for .NET Remoting Services may be downloaded from 

the CyberStoreForSYSPRO.com website. They should be unzipped and placed on 

the SYSPRO ERP server in the following directory: C:\Program Files 

(x86)\Dovetail\RemotingService_{version#}\ 

Configuring Permissions 

 The user account used to run the service is referred to as the “Service User”. 

(Note: in a later step you will select this user account to Register the Service.).  

 Grant the Service User MODIFY access to the SYSPRO Remoting Service Install 

Directory C:\Program Files (x86)\Dovetail\RemotingService_{version#}\ 

 Grant the Service User MODIFY access to SYSPRO Install Directory. This is 

usually C:\SYSPRO61 or C:\SYSPRO60 

 Allow the Service User FULL access to the MicroFocus Registry Keys 

• Start > Run > regedit 

• HKEY_LOCAL_MACHINE\SOFTWARE\Micro Focus 

• For 64-bit Windows OS: 

HKEY_LOCAL_MACHINE\SOFTWARE\wow6432Node\Micro Focus 

 In an environment where the SYSPRO database is using Microsoft SQL, grant 

the Remoting Service User datareader and datawriter permissions to the 

SYSPRO databases for the base SYSPRO system and the specific SYSPRO 

Company CyberStore will connect to. 

Configure the service 

Next, configure the Remoting Service for your local environment. 

 Open the RemotingService.exe.config file located in your C:\Program Files 

(x86)\Dovetail\RemotingService_{version#}\ folder  

 Locate the following section and change the port if needed. 

 

<channels> 

<channel port="8081" ref="tcp" /> 

</channels> 

 

This sets the Port at which the service listens for incoming CyberStore requests 

for SYSPRO. All requests made to the service must use this port number. 
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Note: Simply for maintainability, Port 8081 is recommended for use by CyberStore 

2 unless this port is already in use by another application, in which case try port 

8082 and so on. 
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 Locate the following section and change the path in the ERL_ERrorLogLocation 

value as needed. 

 

<add key="ERL_ErrorLogLocation"  

value="C:\Program Files (x86)\Dovetail\RemotingService _{version#}\remotingservice-

events.log"> 

</add> 

 

IMPORTANT- Two common issues may possibly arise at this point: 

If the service registration fails with the error message “Exception occurred 

while initializing the installation... <Exception from HRESULT:  0x80131515 >" 

use Windows Explorer to check the properties of the remotingservice.exe file. 

If a button labelled “Unblock” is displayed then Windows is preventing the 

execution of this file. Click the “Unblock” button and re-attempt the 

registration process. (If necessary, do the same with the 

remotingservice.exe.config file.)  

If after  registering the service, the service starts but immediately stops, check 

to ensure the log file is located in the same folder as the remoting service,  and 

the key value (above) contains the fully qualified drive path. 

Register the service 

The .NET Remoting Service must now be registered to your Server and the steps to 

do this are detailed next: 

 Open a command prompt. On Windows 2008 or greater “Run as Administrator” 

 Navigate to the .NET Framework folder. To do this, type the following command 

at the command prompt:  

 
cd  c:\windows\microsoft.net\framework\v4.0.30319\ 

 

 Once you are in the v4.0.30319 folder, type the following command to register 

the .NET Remoting Service:  

 

installutil.exe “C:\Program Files (x86)\dovetail\remotingservice 
_{version#}\remotingservice.exe” 

 

Note: be sure to include the double quotes 

 This command, will install the .NET Remoting Service 
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If the above command is successful, a dialog box will be displayed that will prompt 

you for a username and password. The username must be in the format 

DOMAINNAME\USERNAME for an Active Directory user or 

COMPUTERNAME\ USERNAME for a local computer user.. 

 

Figure 5-1. Set Service Credentials in Remoting Service Installation 

If the credentials you enter are incorrect, the service will not be installed and you 

will be shown an error message in the Command Prompt window stating "The 

transact install has failed... rolling back...". 

START the service 

 

Configuring CyberStore 

 CyberStore 2 also must be configured to ensure it sends requests to the 

Remoting Service using the appropriate TCP port. If CyberStore 2 has already 

been installed (or, if not, then once it is) log into the Console and click through 

Set-up > Site Configuration > SYSPRO tab. Here you will find the settings for 

communicating with the Remoting Service. Ensure the TCP port matches the 

port entered previously in the Remoting Service configuration file and the IP 

address is correct for the SYSPRO server. 

 

Configure the Firewall 

If you have any type of firewall running on the SYSPRO server, create an exception 

for port 8081, or the custom port you have defined in the 

RemotingService.exe.config file, with a scope of the IP Address of the CyberStore 2 

web server. 
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5.4 Upgrading .NET Remoting Service to a New Version 

When a new version of the .NET Remoting Service is released, the previous 

version’s installation files must be replaced with those of the new version. The 

following process outlines these steps. 

Download the Updated Remoting Service Package 

 In your web browser, visit www.CyberStoreForSYSPRO.com/download to 

download the latest Remoting Service installation package. 

Stop the CyberStore for SYSPRO Remoting Service 

 Open Windows Services administrator tool on the SYSPRO Server. 

 Locate and select “CyberStore for SYSPRO Remoting Service.” 

 Choose Action -> Stop from the menu. 

 Choose Action -> Properties from the menu. 

 The value for “Path to executable” will indicate the installation directory 

 Close the Properties window. 

Backup Your Current Service Installation 

 Using Windows Explorer, open the installation directory and create a new 

folder called “Backup”. 

 Copy all files in the installation directory into the newly created Backup folder. 

Remove Your Current Installation 

 Delete all files in the installation directory except RemotingService.exe.config 

and any .LOG files. 

Install the Updated Files 

 Copy the files from the updated Remoting Service .ZIP file to this installation 

directory. 

DO NOT overwrite any files 

Restart the CyberStore for SYSPRO Remoting Service 

 Return to the Services administrator. 

 Locate and select “CyberStore for SYSPRO Remoting Service.” 

http://www.cyberstoreforsyspro.com/download
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 Choose Action -> Start. 

5.5 Running Multiple Versions of .NET Remoting Service on the Same Server 

Beginning with version 2.3.2288 of the .NET Remoting Service, it is possible to run 

multiple instances of the service on the same server so long as different version 

numbers are installed separately. 

This is particularly important for users who meet the following criteria: 

 

 You are running multiple CyberStore 2 sites connecting to the same SYSPRO 

server  

 You are running a CyberStore 2 version less than 2.3 on one instance, and 

 You are running a CyberStore 2 version 2.3 or higher on another instance. 

 

An example of the above scenario would be where you are running a production site 

of 2.2.2033 and have a separate staging site that you would like to install and test 

2.3 or higher on prior to rolling up the production instance. 

Installation Differences When Installing Multiple Instances 

You can simply follow the installation instructions in Section 5.3 above being aware 

of the following key differences. 

 

 Skip modifying permissions on both the SYSPRO install directory and the 

MicroFocus registry keys. 

 Create a separate peer installation directory on the SYSPRO server, 

incorporating the remoting service version number in the name. For example: 

C:\Program Files (x86)\Dovetail\Remoting Service_v2.3.2288\ 

 Ensure permissions are properly applied to this new directory. 

 Be sure to update the .config file with the fully qualified drive path to the log file. 

 Be sure to update the .config file with a different TCP/IP port than the other 

running service. 

 Ensure that the corresponding instance of CyberStore 2 also points to this TCP 

port. 

 

You will be able to differentiate the services from each other in the Windows 

Services administrator by the name which will contain the services version within 

when using version 2.3.2288 or higher. 
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6 SYSPRO WEB SERVICES 

6.1 Installation Requirements 

● Internet Information Service (IIS) 7.x installed on the SYSPRO ERP Server 

● Service User credentials including a username and password of the User the 

service will logon as. This is usually CyberStoreRemoting. 

Microsoft Internet Information Services (IIS) 7.x 

On Windows Server 2008: This requirement can be installed through Start -> All 

Programs -> Administrative Tools -> Server Manager. You will then need to add the 

Web Server (IIS) Role. 

IMPORTANT: IIS 7.x will have separate Application Pools per virtual site by 

default. 

Additional Configuration of Internet Information Services 7 Role Services 

The Internet Information Services (IIS) 7 Pre-Requisites listed below are required 

for Windows 2008 and Windows 2008 R2 web servers. 

Install the Web Server (IIS) Role 

 Open the Server Manager in the Administrative Tools 

 Select Roles 

 Locate the Web Server (IIS) section and click “Add Role Services”. If the “Web 

Server (IIS)” role is not already present, click “Add Roles” and select the “Web 

Server (IIS)” role to be added. 
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Choose the appropriate IIS Modules to be installed. See the figure below for details of which 

modules should be installed. 

 

 

Figure 6-1. Base IIS 7 Installation Options for Web Services Setup 
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Set Role Service Options 

In the Confirm Installation Selections interface, review the selections and set the 

following Role Service Options: 

Common HTTP Features (Partial) 

 WebDAV Publishing – Uncheck 

 All other options – Check 

Application Development (All) 

 All options – Check 

Health and Diagnostics (Partial) 

 Custom Logging – Uncheck 

 ODBC Logging – Uncheck 

Security (Partial) 

 Digest Authentication – Uncheck 

 Client Certificate Mapping Authentication – Uncheck 

 IIS Client Certificate Mapping Authentication – Uncheck 

 All other options – Check 

Performance (All) 

 All options – Checked 

Management Tools (Partial) 

 Management Service – Unchecked 

 All other options – Checked 

IIS 6 Management Compatibility (Partial) 

 IIS 6 Metabase Compatibility – Checked (Optional) 

 
Then click Install. Allow the installation process to complete and then click Close. 
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Service User Credentials 

Configuring Permissions 

 The user account used to run the web service is referred to as “Service User” 

(note: in the next step you will select this user account to Update the Application 

Pool.)  

IMPORTANT: When creating this use, it must be added to the local IIS 

Anonymous Group which is either called “IIS_USRS” or “IIS_WPG”. 

 Grant the Service User MODIFY access to the SYSPRO Web Service Install 

Directory C:\inetpub\wwwroot\SYSPROWebServices\ 

 Grant the Service User MODIFY access to SYSPRO Install Directory. This is 

usually C:\SYSPRO61 or C:\SYSPRO60 

 Allow the Service User FULL access to the MicroFocus Registry Keys 

• Start > Run > regedit 

• HKEY_LOCAL_MACHINE\SOFTWARE\Micro Focus 

• For 64-bit Windows OS: 

HKEY_LOCAL_MACHINE\SOFTWARE\wow6432Node\Micro Focus 

 In an environment where the SYSPRO database is using Microsoft SQL, grant 

the Remoting Service User datareader and datawriter permission to the 

SYSPRO databases. 

 

6.2 SYSPRO WEB SERVICE INSTALLATION 

Insert the SYSPRO 6.1 DVD into your SYSPRO Application server.  When the installer 

opens, choose “Installations”, then choose “SYSPRO Web Services” 
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Figure 6-2. SYSPRO Application Setup Screen for Web Services Installation 

 

After the install, open the Internet Information Services (IIS) Manager from the 

Administrative Tools in your Start menu. 

 

Figure 6-3. IIS 7 ISAPI and CGI Restrictions Feature 
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Within the IIS Manager, open the ISAPI and CGI Restrictions Feature 

 

Figure 6-4.  Required Extensions for Web Services Support in IIS 7 

Confirm that the following entries are set to “Allowed” 

- Active Server Pages 

- ASP.NET v2.050727 

o There are two similar entries for ASP.NET v2.0.  Please note the path should 

be to C:\Windows\Microsoft.Net\Framework\ and not to the 64 bit version 

 

Add a new Application Pool by using a right click on Application Pools and select “Add 

Application Pool…” 

 

Figure 6-5. Adding an Application Pool in IIS 7 

 

You should name your new Application Spool “SYSPRO”.  Make sure that the .NET 

Framework version is “.NET Framework v2.0” and that Managed pipeline mode is “Classic” 
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Figure 6-6.  Application Pool Settings for Web Services 

 

 

 

Update the Application Pool 

Select Application Pools in the left hand window pane under your server.  That will display 

all Application Pools in the primary pane of the window.  Select your “SYSPRO” Application 

Pool then choose “Advanced Settings…” on the far right. 

 

Figure 6-7.  Updating the Application Pool 

If you are running a 64-bit operating system, make sure that “Enable 32 bit Applications” is 

set to “True” and click OK. 
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Change the “Identity” to the “Service User” you created in the prerequisites.  

 

Figure 6-8.  Configuring Web Services Application Pool Advanced Settings 

IMPORTANT: If your “Service User” is a local user on the SYSPRO ERP server, 

be sure to preface the user with .\ when updating the Identity user.  For 

example, for CyberStoreRemoting on the local server, you would enter 

.\CyberStoreRemoting. 

 

Update the SYSPROWebServices virtual directory to use the SYSPRO Application Pool you 

just created. 

In IIS Manager, make sure that your virtual site is expanded, then select the 

SYSPROWebServices directory.  On the right hand side of the window, click on  
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“Basic Settings…”  In the resulting window, click the Application pool Select button and 

choose the “SYSPRO” Application Pool. 

 

 

To ensure that all data is secure and encrypted, CyberStore will only communicate with 

SYSPRO using Web Services via a HTTPS connection.  In order to accomplish this, an SSL 

Certificate will need to be created and installed on the virtual web site.   

IMPORTANT: The SSL Certificate must exactly match the URL CyberStore will 

use to communicate with SYSPRO.  For example, if CyberStore will 

communicate via https://10.1.2.3:443/SYSPROWebServices, then the SSL 

Certificate will need to be created for IP Address 10.1.2.3. 

For assistance in selecting or purchasing an SSL Certificate, you can check out 

the handy SSL Comparison Chart located on the CyberStore 2 for SYSPRO 

website at www.CyberStoreForSYSPRO.com/SSL-Comparison-Chart. 

 

 

 

https://10.1.2.3/SYSPROWebServices
http://www.cyberstoreforsyspro.com/SSL-Comparison-Chart


 

 

INSTALLING CYBERSTORE 
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7 CYBERSTORE INSTALLATION WIZARD 

Run the CyberStore 2 for SYSPRO Installation Wizard 

 Make sure that all other applications are closed before running this wizard. 

 When ready, press Next. 
 

 

Figure 7-1. CyberStore Installation - Welcome Screen 

 

Enter or select the desired CyberStore Program Install Path, and click Next.  

Example A “D:\www.theoutdoorscompany.com\CyberStore2” 

Example B “C:\Program Files (x86)\Dovetail\CyberStore2” 
 

NOTE: The installation wizard will prompt with the current location (where you ran 

the installer from) 
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WARNING: Be sure the CyberStore Program Install Path is NOT the same as 
the Virtual Website wwwroot path. 

IMPORTANT: If the CyberStore Installer detects that the destination folder 

already exists and contains the CyberStore DLL files, it will automatically 

switch to Update mode. 

 

 

Figure 7-2. CyberStore Installation - Install Location Screen 
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Select the components you want to install and press next 

 

Figure 7-3. CyberStore Installation - Choosing Components 

 

Select the website to which you will install CyberStore 

If you have not created a specific virtual web site for CyberStore, you may use the 

"Default Web Site".  

This step will ask you if you will be using an SSL Certificate for access to the 

Management Console and public Ecommerce Checkout Process. Select Yes only if 

you already have a SSL Certificate installed on your server. Even if you intend to 

install one at a later date, If you do not have a SSL Certificate installed, select No 

When you have installed your SSL Certificate, please refer to Updating Web.Config 

(page 67) in the CyberStore Installation Guide for information on how to enable 

Requiring SSL. 
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Figure 7-4. CyberStore Installation - Virtual Web Site Selection 

 

Specify the users which CyberStore will be executed as 

This will include indicating whether the users are Local Computer users or Active 

Directory users. You may also let the CyberStore Installer create the users for you.  

WARNING: You will need to be logged into your web server as a Domain 
Admin if you choose Active Directory users, whether you are creating them or 

not. 



CyberStore 2 for SYSPRO Installation and Upgrade Guide  

©2013 Dovetail Internet Technologies, LLC All rights reserved.  Page | 54 

 

Figure 7-5. CyberStore Installation - IIS Users 

 

IMPORTANT: If using AD users specify the username ONLY—the Wizard 

assumes the Domain you are in will be the Domain used and will automatically 

Pre-pend the DOMAIN name before the Username. 

Depending on your server setup, there may be additional steps you will need to take 

SQL and IIS installed on the same server 

 No specific configuration steps required – continue to next step. 
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SQL and IIS installed on two separate servers which are connected to the same NT 

Domain or Active Directory forest 

 In addition to any ports required for NT Domain or Active Directory 

communication, make sure that the IIS Server can access the SQL Server via TCP 

port 1433 through any firewalls that exist between the two servers. 

SQL and IIS installed on two separate servers which are not connected by NT Domain or 

Active Directory. Connection between SQL and IIS will be via Security Support Provider 

Interface (SSPI) 

 CyberstoreBrowsers and CyberstoreManagers must exist on both servers. 

These user names and passwords must be mirrored identically on both servers.  

 The user you are logged into on the web server must exist with the same 

password on the database server. 

 Make sure that the IIS Server can access the SQL Server via TCP port 1433 

through any firewalls that exist between the two servers. 

SQL and IIS installed on two separate servers which are not connected by NT Domain or 

Active Directory. Connection between SQL and IIS will be via a SQL user set in the 

connection string. 

 This configuration is not recommended and not supported in the installer. 
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Figure 7-6. CyberStore Installation - SQL Server Information 

 

Specify the credentials needed to connect to your SYSPRO server 

This information will not be validated at this time. This setup will ask if you will 

communicate with SYSPRO via .NET Remoting and require an appropriate URL. 

Dovetail recommends that all CyberStore instances use .NET Remoting, which is 

installed as .NET Remoting Installation in the CyberStore Installation Guide. 

The Address should be tcp:// followed by either the IP Address, FQDN or Windows 

Network computer name followed by a colon ( : ) followed by a number representing 

the port the .NET Remoting Service is listening on. 

Example: tcp://MyComputerName:8081 

This step asks for your SYSPRO Operator and password. This should be the 

credentials which were created in Step 4 – SYSPRO Setup Pre-Requisites, sub-

section F. 
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This step also asks you for information about accessing your instance of SYSPRO. 

Credentials provided will be encrypted in the database. If your instance of SYSPRO 

does not require the information requested, simply use the default value. 

 

Figure 7-7. CyberStore Installation - SYSPRO Settings 

 

Installer Package will copyr CyberStore 2 for SYSPRO software 

Assuming there are no issues in your environment, the installer package will copy 

the CyberStore 2 for SYSPRO software to your server and setup the appropriate IIS 

Settings, User permissions and SQL Databases. 
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Figure 7-8. CyberStore Installation - Successful Installation 

 

IMPORTANT: If the CyberStore installer fails, please look for the file install.log 

in your installation location for more information. 



 

 

POST WIZARD INSTALLATION 

REQUIREMENTS 
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8 INITIAL SETUP ON WEB SERVER 

After the Software Installation, the following post installation checks and 

configurations are required to be done: 

8.1 Create a MySite Folder for your Templates 

Note: CyberStore provides standard demo templates, named Template1, 

Template2 and so on. One of these can serve as the starting point for your 

company template, defining how your CyberStore will appear to your 

customers. 
 

Note: To preview available controls, you may use “TestTemplate”. This special 

template contains pages with various combinations of all of the controls and 

parameters. 
 

WARNING: Files which are altered or created in any of the CyberStore 

directories (Ecommerce, Console, Documentation, Install and OutdoorsSite) 

will be removed by the CyberStore Installer on an update. In this step you will 

create a directory to keep your customizations intact throughout subsequent 

upgrade procedures. 

File Folder Configuration 

 Create a new subdirectory in the CyberStore Install Path with any name desired, 

perhaps reflecting your company name (e.g. D:\CyberStore2\MySite ). For 

purposes of this document, we will refer to this subdirectory as the MySite 

folder. 

 Choose one of the demo templates as a basis for your CyberStore and copy the 

contents of that template into the newly created “MySite” directory. Your future 

customizations can be safely made here. 

Internet Information Server Configuration 

 In the IIS Manager, create a Virtual Directory for your new Template and in IIS 

point the Virtual Directory /Ecommerce/Site at your Physical MySite folder. 
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IMPORTANT: This step of creating a /Ecommerce/Site virtual in IIS MUST be 
done before you can use the Console to do anything including upload the 

license. 

 

Figure 8-1. Internet Information Services – Add Virtual Directory 
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Figure 8-2. IIS – Add Virtual Directory example 
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8.2 Load License File 

 Logon to the Console by selecting http://yourdomainname/Console and when 

prompted (also located at Tools > License Management), upload the License file 

for the CyberStore.  

IMPORTANT: CyberStore 2 licenses are contained in a single XML file named 
“license.config” and you will need to obtain this CyberStore 2 specific license in 

order to run the CyberStore 2 software. 

8.3 Set Initial CyberStore Configurations 

Enable Runtime License and Refresh the WEB Operator 

 Logon to the Console by selecting http://yourdomainname/Console and navigate 

to Setup > Site Configuration > SYSPRO TAB > Change Operator BUTTON 

 Complete the Default Operator, Password, Confirm Password, Company ID, 

Company Password (if applicable) and Confirm Company Password (if 

applicable). 

 If you are using the SYSPRO e.net Runtime License (Recommended) Check the 

“Use e.net Runtime License” checkbox.  

 

Figure 8-3. SYSPRO Connection Information 

 Click “Save” this will refresh the WEB operator that the CyberStore uses to 

login to SYSPRO. 
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IMPORTANT: You should see a dialog box that indicates the Operator was 
Refreshed Successfully.  

WARNING: If you are unable to Refresh the Operator Successfully then the 

SYSPRO e.net communication may not be working and you should review the 

.NET Remoting Service Setup and other Pre-Requisites. 

Enable Caching (Optional) 

For performance tuning you may use the caching feature and set the threshold for 

retention using the slider and time increment drop-down. 

 To enable caching Check the box. 

Verify Communicate with SYSPRO is enabled 

Communication to the SYSPRO Application may be temporarily disabled if you 

desire. 

 Be sure communication with SYSPRO box is Checked. 

Setup a Local Currency 

● Using the CyberStore 2 for SYSPRO Management console: 

 Create a Currency record for the company’s local currency – Setup > Currency 

> click Add icon 

Setup Payment Profile 

 Create a Payment profile record – Setup > Payment Profile 

 Please refer to the CyberStore Administration section of the CyberStore 2 for 

SYSPRO workbook for instructions on configuring Currency and Payment 

Profile details. 

Setup Email 

 Setup > Site Configuration > Email TAB 
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9 POPULATE YOUR STORE 

You are now ready to start configuring the rest of your CyberStore system. Refer 

to the following sections: 

 Populate your site with the necessary data – See the CyberStore 

Administration section in the CyberStore 2 for SYSPRO Workbook. 

 Customize your site pages - See the CyberStore Site Design section in the 

CyberStore 2 for SYSPRO Workbook. 

10 GO LIVE 

 Obtain and install an SSL 

 Configure an external IP address and update your domain records to resolve to 

it. 



 

 

UPGRADE CYBERSTORE 1 TO 2 
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INSTALL A NEW SITE 

Perform the Pre-Requisites 

Perform Installing CyberStore  

 Perform Installing .NET Remoting Service 

 Setup a separate .NET remoting service on the SYSPRO server. Make sure this 

runs under a different PORT than version 1 

Perform Post Installation Requirements 

 

MIGRATE YOUR DATA AND SETTINGS 

Backup and Migrate a copy of your version 1 Database 

 Restore over the CyberStore2 database a backup of your CS1 

SYSPROCyberStore database. 

IMPORTANT: Be sure to specify the correct Paths to the database file and 

log file before running the restore. 

 Run the CyberStore Installation Wizard again which will automatically run as an 

Upgrade. This will cause the database to be upsized with the existing data in 

place. 

IMPORTANT: Be sure to specify the correct database name for the CS2 

version (e.g. “SYSPROCyberStore2”).  

Update the Web.Config 

 Merge the App Settings from the CS1 /Ecommerce/web.config into the CS2 

/Ecommerce/web.config.  

IMPORTANT: Replace all of the App Settings except the Connection 

attributes and Company attributes. 

Rename CS2_ Controls (BETA Users Only) 

Several controls were introduced during the development cycle that were 

eventually merged back into the default controls. Any references to these controls 
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will need to be changed in the sitepages.config file (in the /xml directory) and any of 

your customizations merged in.  

 

CS2 Beta Control Name CS2 Final Release Control Name 

CS2_CatalogCategoryNavigationControl.ascx CatalogCategoryNavigationControl.ascx 

CS2_CatalogHotbuyControl.ascx CatalogHotbuyControl.ascx 

CS2_CatalogRelatedItemsControl.ascx CatalogRelatedItemsControl.ascx 

CS2_CatalogSearchControl.ascx CatalogSearchControl.ascx 

CS2_DistributorSearchControl.ascx DistributorSearchControl.ascx 

CS2_ItemDisplayControl.ascx ItemDisplayControl.ascx 

 
 

UPGRADE THE SITE TEMPLATE 

Clear out the Demo template from the MySite folder 

IMPORTANT: Be sure to clear out the MySite folders if they were established 

during the prior Fresh Install Post Installation Setup. This will allow you to 

assemble a new clean MySite template by combining new and old files in the 

following steps. 

Copy your MySite folder from the CyberStore 1 program location to the 

CyberStore 2 program location 

For example: 

 FROM: C:\Program Files (x86)\dovetail\e-Commerce System\MySite 

 TO: D:\CyberStore2\ MySite 

Merge Certain New Files from the new CS2 Demo templates 

“/Themes/css” 

Add Files 

 Accessories.css – contains styles for new CS2 features such as the Accessory 

Selector, Shopping Cart, Add to Cart. 

 CS2.css – contains the styles from Controls.css and Theme.css that are new to 

CS2 (not present in your existing 1.x files) 
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 /smoothness/*.* (folder) – contains jquery css and images folders. 

Add @import references to your CSS files for new CS2 styles 

 Add the following lines to the beginning of your existing main CSS file in the 

MySite template (e.g. DECTheCatalog.css, Theme.css, or whatever your main 

CSS file is named): 

 @import url(‘Accessories.css'); 

 @import url(‘CS2.css'); 
 

Warning: Avoid duplicate CSS class and ID settings if you are already using 

@import references. 

 

“Themes/images” 

Combine the files from the /Themes/images directory. 

Some credit card images are new. 

 

“/js” 

Add new files 

 jquery.tipsy.js 

 jquery-1.4.2.min.js 

 jquery-1.6.2.min.js 

 jqquery-ui-1.8.5.custom.min.js 
 

“/control” 

Combine 

 Copy in any (custom) controls from the new CyberStore 2 template that aren’t 

in the MySite template. 
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“/content” 

Copy in any CS2 content files that aren’t already in MySite 

IMPORTANT: Do NOT overwrite any files that already exist in MySite 

Create new folder 

 Add a folder called /images inside your theme’s /content folder to receive any 

images uploaded in the new CyberStore 2 Long Description editor. 

Clean up HEAD (Optional) 

Review your Theme ASCX files and remove BODY, HEAD and HTML tags if they are 

NOT modified (e.g., if you have an onload function in the opening <BODY> tag). 

Leaving these tags in place will not cause the site to error, but a full set of them are 

inserted by the CyberStore page rendering engine. Having them in your themes will 

result in duplicates.  

Update Custom Controls 

To make your custom CS1 controls work with CS2 the following code (at minimum) 

needs to be modified. 

 Remove: TargetSchema=”http://schemas.microsoft.com/intellisense/ie5”; 

 Change: AutoEventWireup=”false” to AutoEventWireup=”true” 

 Change: Inherits=”Dovetail.Ecommerce.Control.CatalogHotbuyControl” to 

Inherits=”Dovetail.Ecommerce.Controls.CatalogHotbuyControl” (“control” to 

“controls”). 

 Merge Customizations 

For each control that has been customized, merge the previously customized 

changes into the new standard controls being sure to keep the CS2 business logic 

in place. 

HINT: A tool such as WinMerge is helpful for this step. WinMerge can be 

downloaded for free from http://winmerge.org/. 

HINT: If you are having trouble determining what has changed, it might be 

helpful to compare the base CS1 control to your customized CS1 control. That 

way you can see (and isolate) the changes that you made originally. 

http://winmerge.org/
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IMPORTANT: You may turn on/off Custom Controls in the Console 
(>Setup>SiteConfiguration, Paths tab. This is useful to determine if your site 

is working with the base CS2 controls.  



 

 

UPDATE INSTRUCTIONS 
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UPDATING CYBERSTORE 2 WITH MINOR BUILDS 

 Before the update Block traffic to the site. 

 Download and run the update/installation wizard. An Update will happen when 

the CyberStore Installer detects that it is being installed over an existing 

directory structure which contains CyberStore DLLs. 
 

IMPORTANT: Be sure to specify the correct Install Path (e.g. D:/CyberStore2) 

 

 

Figure 10-1. CyberStore Detecting it should Update 

 If CyberStore is operating properly, then simply enter the appropriate data for 

your SQL Server.  If CyberStore is not operating properly, please review step 0 

in the Installation section. 
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Figure 10-2. CyberStore SQL Server Selection during Update 

 

 The CyberStore Installer will then proceed to do the following actions: 

• Create a backup of the currently installed version. This backup will be 

named CyberStore 2 for SYSPRO X.X.X.zip and placed in the Backup folder 
in your CyberStore installation directory 

• Connect to your SQL Server and issue a SQL Backup command for the 

Public Site Database and Management Console databases. These backups 

are stored in your SQL Server default backup directory 

• Update the files in your CyberStore installation directory and remove 

unused files. This procedure will remove or replace all files in the 

Ecommerce, Console, Install, or OutdoorsSite directories. DO NOT run the 

CyberStore update if you have customized files in these directories. 

• Execute Schema and required Data updates to the Management Console 

database. 

• Execute Schema and required Data updated to the Public Site database. 
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 Once all update actions are complete, a file called install.log will be created in 

your CyberStore installation database. This file will contain all actions 

performed during the automated update. 

 If you have custom controls merge the new control changes into your previously 

changed control copies in the /*yoursite*/control folder. 

 After the Update 

• Refresh the operator 

• Place a test order 

• Allow traffic to the web site. 

 
 



 

 

UNINSTALL INSTRUCTIONS 
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UNINSTALLING CYBERSTORE 2 

Remove local users 

CyberStoreBrowsers 

CyberStoreManagers 

Remove databases associated with this installation 

SYSPROCyberStore 

SYSPROCyberStoreConsole 

Note: You may need to take the database Offline before deleting it. 

Remove virtual directories / applications which were created with this install 

/Console 

/Ecommerce 

Remove application pools which were created with this install 

Default WebSite – CS2Console 

Default WebSite – CS2ECommerce 

Remove the Cyberstore files and folders from the CyberStore Installation (physical) path 

Except for Website root D:\Cyberstore2\ 



 

 

TROUBLESHOOTING YOUR 

INSTALLATION 
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INSTALLATION ERRORS 

There are some cases where the Installation program may fail due to an improperly 

configured or outdated system. In these cases, it is necessary to carefully make a note 

of the error messages, and once the CyberStore 2 for SYSPRO Installer has completed 

the installation process, you will then need to manually modify certain settings on the 

system. 

The following sections should assist in modifying the system in the case of 

installation errors. 

 

VARIOUS TROUBLESHOOTING SCENARIOS 

OOPS Error 

When e.net objects are used, an OOPS error occurs on the SYSPRO Server.  

This error is related to the registry settings on the SYSPRO Server: 

The CyberstoreBrowsers and CyberstoreManagers need Full Control Permissions 

on HKEY_LOCAL_MACHINE\SOFTWARE\MICRO FOCUS. To correct this: 

 Go to start >> Run and type regedt32 

 Browse to HKEY_LOCAL_MACHINE\Software\Micro Focus 

 From the File menu select Edit > Permissions 

 Add the eCommerce Users, and grant Full permissions 
 

There should be a PATH variable under the 

HKEY_LOCAL_MACHINE\Software\Micro Focus\Net 

Express\4.0\Cobol\4.0\Environment. If this is missing, then add the PATH variable 

as an Expandable String Value type. If the PATH variable does exist, then make sure 

its value is: “[BASE]”;[BASE];%PATH% where [BASE] is equal to the physical path to 

the SYSPRO Base folder 

“Object Reference not set Equal to an Object” ....DEP – Data Execution 

Prevention 

The error message displayed is: “Object Reference not set Equal to an Object” Error 

Reported In Logs. 

This error can occur if the Data Execution Prevention feature has mistakenly 

determined that e.net is a Security threat. For more information on this feature see 

http://support.microsoft.com/kb/875352 

http://support.microsoft.com/kb/875352
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The following behavior accompanies this error: The Ecommerce Diagnostics tool 

will work without incident. VB programs using e.net will be shut down by windows 

and create a Dr. Watson Error. 

 

Figure 10-3. Data Execution Protection (DEP) Windows UI 

 

To view the settings for DEP, select: 

 My Computer > Properties > and then select the Advanced Tab 

 Under Performance, select Settings, then select the Data Execution Prevention 

Tab. 

 This problem can occur if this is set to Turn on DEP for all programs and services 

except those I select. To allow e.net to work using the.NET Remoting Client, follow 

the steps below: 

 Install the .NET Remoting Application 

 In the DEP properties window, click Add and locate the .NET remoting 

application, i.e. C:\Program Files (x86)\dovetail\remoting 

service\remotingservice.exe, then check the new entry. 
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 Restart the service. To do this, right click on My Computer on your desk top and 

select: 

• Manage > Services and Applications > Services 

• Locate the service named SYSPRO Ecommerce Remoting Service. 

• Select the service and click the Restart button. 

Server cannot access application directory .... 

The error message displayed is: Server cannot access application directory 

'<ecommerce directory>'. The directory does not exist or is not accessible because 

of security settings. 

Please refer to the File Permissions section of this document, on page: Error! 

Bookmark not defined. 

Order type '{blank}' is invalid .... 

The error message displayed is: Order type '{blank}' is invalid for order 

'<PONumber>' 

Please refer to “SYSPRO Default Order Type for Sales Orders” in the Pre-

Requisites section of this guide. 

Access to business object <objectname> denied 

This message will be in the log files when e.net is not working properly. 

This message may also be displayed in the Diagnostics Tool, as well as the 

Import/Export tool. 

To correct this problem, review the “e.net Group Security” section of this document 

Changing A Theme Takes Partial or Has No Effect on the Site 

After changing a theme do the following: 

 Locate the site directory in IIS, under the Ecommerce Virtual. 

 Make a change to the web.config file in the ecommerce Programs folder, such as 

adding a blank line. This is to cause the web application to do a recompile. 

 In your web browser, delete the cache to make sure you see all of the changes, 

and press CTRL + F5 to refresh the page. 



 

 

APPENDICES 
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APPENDIX A    TECHNICAL INTERVIEW 

Network Discovery 

1 What type of network hardware (switches, hubs):      

             

2 What type of network appliances (proxy servers, firewalls, routers, etc):   

             

3 Logical Network Location (IP Address, location on network diagram): 

a. CyberStore Server:           

b. CyberStore SQL Server:           

c. SYSPRO Server:           

d. SYSPRO SQL Server:           

 

4 Does this network use Workgroups, NT Domain or Active Directory:   

             

5 Are all of the servers on the same Workgroup, NT Domain or Active Directory? 

Indicate the name and type of Windows Network the following servers are on: 

a. CyberStore Server:           

b. CyberStore SQL Server:           

c. SYSPRO Server:           

d. SYSPRO SQL Server:           

 

6 Describe the bandwidth and network uplinks between the CyberStore server, the 

SYSPRO server and the Internet:         
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7 Discussion of what network traffic limitations (if any) will be imposed on the 

CyberStore server:           

            

             

8 Create Network Diagram: 

Server Discovery 

1 CyberStore Server 

a. Name of Server:           

b. IP Address:            

c. Physical or Virtual Server? If Virtual, what platform (Hyper-V, VMWare, 

Other):           

  

d. Operating System:           

e. Anti-Virus Software (Name and Version):        

f. Firewall Software (Name and Version):        

 

2 CyberStore SQL Server 

a. Name of Server:           

b. IP Address:            

c. Physical or Virtual Server? If Virtual, what platform (Hyper-V, VMWare, 

Other):           

  

d. Operating System:           

e. SQL Server Version:           

f. SQL Server Edition (Express,Standard,Enterprise):     
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g. Anti-Virus Software (Name and Version):        

h. Firewall Software (Name and Version):        

 

3 SYSPRO Server 

a. Name of Server:           

b. IP Address:            

c. Physical or Virtual Server? If Virtual, what platform (Hyper-V, VMWare, 

Other):           

  

d. Test or Live SYSPRO Server:        

  

e. SYSPRO Version and Port is currently in use:      

  

f. SYSPRO database C-ISAM or Microsoft SQL:      

  

g. Operating System:           

h. Anti-Virus Software (Name and Version):        

i. Firewall Software (Name and Version):        

 

4 SYSPRO SQL Server (if different) 

a. Name of Server:           

b. IP Address:            

c. Physical or Virtual Server? If Virtual, what platform (Hyper-V, VMWare, 

Other):           

  

d. Operating System:           

e. SQL Server Version:           
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f. SQL Server Edition (Express,Standard,Enterprise):     

  

g. Anti-Virus Software (Name and Version):        

h. Firewall Software (Name and Version):        
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5 Email Server (Required for emailed receipts and alerts) 

a. Name of Server:           

b. IP Address and Port:            

c. If this server is NOT an open SMTP relay for the CyberStore Server, then 

Authentication information: _________________________    
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APPENDIX B    PRE-REQUISITES CHECKLIST 

The following Pre-Requisites will need to be in place before implementation can begin: 

Web Server 

 Operating System (O/S) installed 

 Microsoft IIS installed 

 Microsoft IIS Configured with Server Roles 

 Microsoft .NET Framework 4.0 installed 

 Virtual Website Created 

 DEP Updated 

 Network, Server and Site setup respond to assigned IP address (for example it will 

display a default Microsoft IIS7 Construction Page) 

 All Security Updates and Important or Critical Windows updates that relate to 

required components applied 

 SSL Certificate for full subdomain and domain name of CyberStore site (e.g. 

ecommerce.yourdomain.com (necessary for Go Live) 

SQL Server 

 Operating System (O/S) installed 

 SQL Server installed 

 Confirmation that SQL Named Pipes are enabled 

 All Security Updates and Important or Critical Windows updates that relate to 

required components are applied 

Network 

 High speed business level internet access with dedicated IP allocation on port 

80/443 for the CyberStore 

 Public IP Address mapped to DNS Entry (e.g. ecommerce.yourcompany.com) 

 Confirmed firewall/VPN configurations (as needed) to facilitate: 

 Communications from CyberStore Server to SYSPRO Server on port 8081 
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 Communications from CyberStore Server to SQL Server on port 1433 and additional 

MSSQL ports 

 Confirmed that three Windows Service Accounts are created: 

CyberStoreBrowsers 

CyberStoreManagers 

CyberStoreRemoting 
 Confirmed that Windows Service accounts have passwords set to not expire 

 

SYSPRO Server 

 SYSPRO ERP is installed and it is the only instance installed on the SYSPRO 

application server. 

 SYSPRO updated to latest port 

 SYSPRO e.net solutions installed on SYSPRO Server 

 SYSPRO e.net Diagnostics Tool installed on SYSPRO Server 

 Configuring the e.net Licensing 

 Verifying that e.net Browse are setup 

 SYSPRO Group exists 

 SYSPRO Group has appropriate permissions 

 SYSPRO WEB Operator exists 

 SYSPRO WEB Operator has appropriate permissions 

 

SYSPRO Server – Communication Services (Choose One)  

CyberStore 2 for SYSPRO Remoting Service 

 Microsoft .NET Framework 4.0 installed on SYSPRO server 

 CyberStore 2 for SYSPRO Remoting Service is installed, started and set to 

Automatic Start 

 <Can’t do this until after install CyberStore Application> e.net Communication 
working between CyberStore and SYSPRO Server 

SYSPRO Web Services 

 SYSPRO Web Services Installed  

 Trusted SSL Certificate installed and bound to appropriate ports. 

<Can’t do this until after install CyberStore Application> e.net Communication 
working between CyberStore and SYSPRO Server 


